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About the Release Notes 
SpringCM Release Notes address new enhancements and fixes to the SpringCM platform as 
well as to the SpringCM desktop and mobile apps. 

 
The SpringCM team is always looking for opportunities to grow and innovate. Your feedback is 
essential to help improve our product as well as the documentation and online support. Please 
share what you like and what you don’t by sending your feedback to built4me@springcm.com. 

Primary 

Release Overview 
With this release, SpringCM customers can take advantage of many exciting, new features 
and enhancements that will improve the overall experience for end users, administrators, 
partners and customers. Please contact SpringCM Customer Success 
(success@springcm.com) if you have questions regarding these features in your account.  
 
Administrators are encouraged to share the information in this document with the users in their 
own organization.  
 
Please visit our Trust Site for more information about scheduled downtime for this release and 
other upcoming maintenance windows: https://trust.springcm.com/ 
 

End of Life Announcements 
In January 2016, SpringCM will no longer support version 9 of Microsoft’s Internet Explorer 
desktop browser. Users are encouraged to access their SpringCM accounts by using a more 
recent version of Internet Explorer or other web browser such as Google Chrome, Apple Safari 
or Mozilla Firefox. Please check with your System Administrator or IT department to determine 
the best alternative browser.   
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Enhancements 

Track It™ for Deal Visibility 

SpringCM customers are looking for more visibility into their running document workflows. In 
close collaboration with our end users, SpringCM has created Track It, a new mobile app that 
provides users with unprecedented visibility into the current state of any document in motion. 

Track It will be available in Salesforce1 and works out of the box with any object that is 
configured to use SpringCM’s File It™. In Track It, a user clicks into an active documents list to 
view an activity board showing all workflow activity for a particular document in motion. 

The Active Documents list and the Activity Board will provide visibility into the current stage of 
the workflow, including:  

• Who is responsible for the next action 
• The task that was assigned 
• The date this task was assigned 
• The due date of the task 
• Whether the current assignee has viewed the document 

The app launches to show a list of active documents in the current folder or subfolder(s). An 
"active document" is one that is currently part of an active workflow that has tracking data 
enabled to capture information around human steps. 

The Track It Activity Board also provides visibility into past activity in the workflow, including: 

• Who took the action 
• The output of the step (the action taken) 
• The date the step was completed 
• Comments (if any) 

Users can scroll through the list and have the option to expand steps that hold additional 
information (e.g. the workflow user's comments) 

With a single click from the Activity Board, the user may send an email to notify users about 
pending or overdue actions. 

Track It is built entirely on SpringCM’s REST API, released earlier this year and leverages a 
growing UX Component Library. While this initial release is aimed at Salesforce customers 
using Salesforce1, Track It will be available outside Salesforce as a standalone mobile app 
and as a native feature for SpringCM platform customers.  
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Please contact your SpringCM representative for more information on getting access to Track 
It.  

NOTE: Track It is only capable of displaying activity for properly configured SpringCM 
workflows. This feature must be enabled for the customer’s account and optionally 
enabled per workflow. 

 
 
 
 
Editions  Available Via  Available To 

Business   Web UI   Guest  

Enterprise X  Salesforce1 X  Full Subscriber X 

Premier X  Mobile   Administrator X 

   Desktop Apps     

 

External Review 

Completing reviews with outside parties is a critical step in any approval process where 
internal and external parties are collaborating around key documents. This is especially true for 
customers working with Contracts and other agreements. 
 
In the July Release, SpringCM introduces an entirely new way for you to collaborate with your 
external customers, vendors, and partners. The new External Review process lets you share, 
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capture feedback, and even redline important documents with 3rd parties - all without using 
email attachments. 
 
Our customers have expressed these particular challenges in using email attachments: 
 
• No versioning of documents as the go 

back and forth 

• Not locking documents while out for review 

• No history of activity in the document’s 
audit trail 

• No way to automate emails as part of 
larger review/approval process 

• No due dates or way to expire external 
review requests 

• Nightmares when emails with 
attachments are forwarded to other 
parties 

• No easy way to notify interest parties 
about the status of reviews in progress 

• No visibility into who has the next action 
and alerts if things are falling behind 

 
 
SpringCM has worked with its customers to revisit the entire external review process and has 
developed a powerful alternative to the challenges and pain associated with passing email 
attachments back and forth. 
 
The improvements can best be described using a set of personas representing the parties 
involved in a typical External Review process: 
 

• Tim is a SpringCM user looking to have his customer accept the terms of a particular 
agreement like an NDA, MSA, or Statement of Work. 

• His external counterpart, Walter is not a SpringCM user and routinely communicates 
with Tim over email. 

 

Starting the Review 

Tim can start the External Review process for a document manually in the browser although 
the activity can also be started as part of an automated workflow or through SpringCM’s API. 
As Tim is preparing to send his document external review, he can:  
 

• Select Walter by name from his company address book.  Tim can only select a single 
recipient.  

• Optionally add 1 or more recipients, SpringCM distribution groups, or SpringCM security 
groups as watchers who can follow the progress of the review 

• Use a rich text editor for composing a message to Walter and viewing the custom 
branded email before clicking Send 

• Set a due date 
• Add his personal SpringCM signature to the email 
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In addition to a branded email that helps Tim present himself and his company more 
professionally, Walter will also be greeted with a nicely-formatted, branded page that makes it 
easy for him to complete his tasks. 

Completing the Review 

Walter begins by clicking a button in Tim’s email to navigate to a branded page where he can 
review the document, reply with comments, and/or upload a redlined version, if necessary. If 
Walter needs to complete the review with a redlined document, he must select a document of 
the same type. He will receive a warning message if he does not select a document of the 
same type.  
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Walter receives a branded email from Tim  
with a clear call to action for completing the Review 

 

 
Clicking on the button in the email invite from Tim 

brings Walter to a page with instructions on how to start the Review 
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Tim, Walter, and any watchers will receive an email when Walter completes the external 
review process.  
 
The web page remains available until the External Review process expires in order to provide 
a reference point for communication during the contract process.  
 
As the process ensues, Tim and any watchers will receive notifications any time there is 
activity around the Review process including: 
 

• When the activity is completed 
• When the activity expires 
• When the activity is cancelled 

Cancelling External Review 

Only Tim or a Super Admin can cancel a document that is out for external review. When the 
Review is cancelled, Walter receive an email letting him know it has been cancelled. Tim can 
cancel the review by selecting the Cancel External Review action in a context menu  or in the 
Edit Menu.  If the review has expired or cancelled and Walter tries to go to the web page, he is 
provided an experience that makes it clear that the review is no longer valid.  
 

 
 

History Messages 

During the review process, SpringCM keeps track of all the activities that take place.  We have 
added a next added new history filter for External Review activities and provide more detailed 
information as each activity occurs. New history messages are recorded.  
 

• When external review starts 

• When it is completed and how it completes 

• When it expires 
• When it is cancelled 

• When a user accesses the page 

• When a user downloads the document 
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Advanced Workflow  

External Review can be initiated during your business process in two ways from an advanced 
workflow.  
 

• Send for External Review 

The Send for External Review workflow step allows the document to be sent to the 
reviewer in an automated fashion. In this case, Tim does not need to review the 
document before sending it out. A new Send for External Review workflow step has 
been introduced in conjunction with this release. This step aligns with the new process 
and incorporates new output paths that align with the process as well as incorporates 
the new Watchers capabilities.   New business processes that will utilize this step 
should use this new workflow step.  
 
If your organization has implemented a workflow that utilizes the legacy Send for 
External Review workflow step, then it will continue to work as it does today.  Over the 
next 6 months, SpringCM will work with you to migrate from the old Send for External 
Review step to the new workflow step.  
 
If you are using the old Send for External Review step, you will see a warning indicator 
in the Workflow Designer or the Process Monitor. This indicator only means that you are 
using an old step; it does not mean that there you have an issue to correct or that the 
workflow is broken.  
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• Review and Send for External Review, Wait for External Review 

The Review and Send for External Review step allows the sender (Tim) to review the 
document prior to sending it out for external review. Here, Tim can change the recipient, 
the due date, the subject and message prior to sending it out to his customer, prospect, 
or vendor. 

 
This step works in tandem with the Wait for External Review step.  This step need to be 
incorporated into your workflow after the aforementioned step completes and allows the 
workflow designer to trigger downstream processes based on whether the step 

 

• completed with a document 
• completed without a document 
• cancelled 
• expired 
• was sent to an invalid recipient 

 

REST Web Service 

SpringCM has also extended our REST API to include a web service to start an External 
Review process programmatically. This call only supports the new External Review feature 
and is only used for sending . No changes or cancelling an external review process is 
supported. 
 

Inflight documents out for External Review  

Documents that are currently out for External Review at the time of this release will continue 
following the old process.  This means that for anything this currently out for review will 
complete via the email attachment process.  Any documents sent out for external review after 
the release will utilize the new send and complete interactions. 
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Editions  Available Via  Available To 

Business X  Web UI X  Guest  

Enterprise X  Salesforce X  Full Subscriber X 

Premier X  Mobile X  Administrator X 

   Desktop Apps     

 
 

Document Package Builder 

Starting with the July Release and continuing on for the next few releases, SpringCM will be 
enhancing its document generation features to address a number of usability challenges, 
especially related to the management of MS Word and XML templates. 
 
In the July Release, we have introduced several methods for including common paragraphs, 
terms, and clauses in your templates. This makes it easy to make changes to your text without 
having to touch your MS Word/PDF templates or your configuration. 
 
Document Generation Administrators can now create paragraphs as separate text or html 
documents and managed them like any other document in a SpringCM folder. Alternatively 
they can use the new, native SpringCM Extension Term (or SXTerm) document type to 
manage a number of related terms in a single document. 
 

New Extraction Sources 

Four new extraction sources are available for merging data into MS Word or PDF templates. 
Admins can now specify the following values to merge data from these sources: 
 

Type extractionSourceID Example sourceIdentifer 

Text SCMPlainTextFile /Admin/Clauses/SimpleTextClause.txt 

Terms SCMTermDocument /Admin/Clauses/Indemnity.sxterm?option=Fallback 

JSON JSONExtractor Employees.JohnSmith.startDate 

XML XMLExtractor //Employees/JohnSmith/startDate 
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Editions  Available Via  Available To 

Business X  Web UI X  Guest  

Enterprise X  Salesforce1   Full Subscriber X 

Premier X  Mobile   Administrator X 

   Desktop Apps     

 

Document Reminders 

Building on the enhancements released earlier this year, the Document Reminders feature has 
been updated again, this time to allow SpringCM Administrator to create new Reminders as 
Smart Rule Actions. This makes it easy for customers to automate the creation of Document 
Reminders based on other important activity in the account such as a document being 
checked in or returned from an External Review or eSignature. 

• The Smart Rule Action provides a list of valid Reminder Templates that contain at least 
the minimum required parameters for new Reminders. 

• Reminder dates will be calculated using one of the two date offset methods (apply date 
or date attribute value) 

 

 
 

Admins can use Smart Rules to apply new Reminders to documents 
using existing Reminder Templates 
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Smart Rules also now support the ability to fire a rule based on a new event called Document 
Reminder Processed. This extends the power of using Document Reminders to automate 
activities and document business processes in SpringCM. 
 

 
 

Administrators can trigger new Smart Rules when a Reminder is processed 

 

 

 

Editions  Available Via  Available To 

Business X  Web UI X  Guest  

Enterprise X  Salesforce1   Full Subscriber X 

Premier X  Mobile   Administrator X 

   Desktop Apps     
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Workflow Improvements 

• The Start Step in SpringCM’s Advance Workflow Designer has presented technical 
challenges for many new users. In the July Release, we have made it much simpler to 
configure a new workflow by dramatically reducing the steps required to get started.  In 
addition to passing in custom xml to start a workflow process, the designer can now 
bootstrap the workflow by selecting a specific document or folder.  
 

 
Workflow Developers can quickly bootstrap a new workflow 

by selecting a document or folder in the repository 

 
 

• The Send Email workflow step now sends a single email to all valid recipients when 
called through an Advanced Workflow. The step will fail if no valid recipients are found. 
Prior to this release, the step sent a separate email to all recipients.  

 

Editions  Available Via  Available To 

Business   Web UI X  Guest  

Enterprise X  Salesforce1   Full Subscriber X 

Premier X  Mobile   Administrator X 

   Desktop Apps     
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REST Application Programming Interface (API) 

With the July Release, we have made the following updates to the REST API: 

• There is a new endpoint for obtaining a URL to DocLauncher, the successor to 
SpringCM’s Document Package Builder to be formally released later in 2015. Additional 
information about this endpoint as well as examples on how to use the API are available 
on SpringCM’s Developer Center. 

Developer Center 

SpringCM is proud to announce the launch of our new Developer Center, a site built for our 
technical audience to help guide them in integrating and building custom solutions on the 
SpringCM platform. SpringCM has hosted the Knowledge Center for quite some time which 
offers guidance on configuring SpringCM from an administrative perspective.  We are now 
happy to complement that with the Developer Center, which will focus on SpringCM from a 
development perspective. 

  
The SpringCM Developer Center launches in July 

This first release focuses on the SpringCM REST API, SOAP API, and SSO integration 
capabilities. While the SOAP API has been around for several years, the REST API was 
officially launched in June of 2015 and was purposely developed to align with modern 
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standards and capabilities. The REST API will be the primary focus for future enhancements 
and already exposes additional capabilities not seen in the SOAP API such as “Sharing”, the 
“Workflow Inbox”, and “Document Reminders”.  Look for more to come throughout the 
remainder of 2015. 

In addition to the Guides, we are also launching the SpringCM Tech Blog.  The tech blog will 
contain posts focusing on newly released features, best practices for working with SpringCM, 
and experiences/guidance from our tech team that we have gained in building the SpringCM 
platform. 

Other Enhancements 

In addition to these new features, SpringCM has delivered the following enhancements in this 
Release: 

• Email Branding – In recognizing that SpringCMs’ customers use the platform for 
communicating and collaborating both internally and externally, we have updated the 
branding features to allow Administrators to set custom footer messages and to include 
a custom logo in all outbound emails.  

 

In the updated Branding page in the Preferences section,  
Administrators can create a custom footer message for all outbound emails 

 

• New Login Page – To help support a single, more responsive login page used on 
desktops, mobile devices and in 3rd party apps like Salesforce.com, we have rebuilt the 
all-important login page to better accommodate different environments.  
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The new SpringCM login page is optimized for desktop and mobile devices 
 

• Premium Feature prompt – We have removed the in-app promotion of disabled 
features so that clicking on a feature not available in the user’s account no longer 
prompts the user to upgrade. 

• Large Folders –   Through research, we discovered that when users are tasked with 
browsing through folders with an unusually large number of items, they are very rarely 
successful in finding what they are looking for.  They start paging through the first few 
hundred lines and then abandon the task and choose to use search. To provide a better 
experience, we will no longer show the content of folders with greater than 10000 items.  
Instead, we post a message in the user interface that coaches them to use search to 
find what they are looking for.  This also provides the added benefit of reduced load 
times for folders across the system.  

o When the user attempts to browse a folder that contains larger than 10,000 items 
(documents, folders, E-forms, links), a message will be returned, encouraging 
use of search to find the document or folder.  After selecting the search link in the 
message, the user will be taken to the Advanced Search page where filters can 
be applied to find documents or folders.  
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o When attempting to browse a folder than contains more than 10000 items via 
FTP or SFTP, a permission denied message will be returned. In this case, you 
can bypass this error by going directly to the document or folder.  

o When attempting to browse a folder than contains more than 10000 items via 
WebDAV, a permission denied message will be returned. In this case, you can 
bypass this error by going directly to the document or folder.  

• Document History – Accessing Document History has been moved from the Edit Menu 
to the View Menu.  

• DocuSign Envelope Download – We have added a feature that allows a user to 
download the contents of a DocuSign envelope. Prior to this feature, Only the 1st 
document from a DocuSign envelope was presented to the user. Now all the files from 
an envelope are available for use.  

• Single Sign On – To maintain environmental parity, a configuration change is being 
made to the SpringCM Service Provider information used in the implementation of 
SAML SSO. If your account is in the Las Vegas data center (NA21), you will need to 
make changes. More information can be found here.  
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Fixes 

Summary Components 
Fixed an issue where a document sent out for external review via 
workflow was not cancelled properly when the active workflow 
was aborted.  

Workflow 

Fixed an issue where a document sent out for signature via 
workflow was not cancelled properly when the active workflow 
was aborted.  

Workflow 

Two Actions related to the deprecated Expiration and Reminder 
feature that were previously available on the Notification 
Preferences page in the user’s My Preferences section have 
been removed. The Document Expiration Notice Sent and 
Document Reminder Notice Sent actions are no longer available 
on this page. 

Expiration and Reminders 
(deprecated) 
 
User Preferences 

The legacy stock report Expirations and Reminders is no longer 
visible in the Reports section as the feature was removed in the 
June 2015 Release. 

Reports 

Fixed an issue where special characters were not handled 
properly when they were used in File It.  

Salesforce (File It) 

Fixed an issue where Users were not able to create new XML 
variables 

Workflow 

Fixed an issue where downloading a document without an 
ACCEPT header from Salesforce returned the preview image. 

Web Services (REST API) 

Fixed an issue where copying a Salesforce folder would also 
copy its resultant attributes.  

Salesforce 

Fixed an issue where a document sent out for signature via 
Echosign would not always follow the specified order.   

Electronic Signature 
(Echosign) 

Fixed an issue where creating a new smart rule after selecting 
the initiator and clicking the Add Action link would return an error. 

Smart Rules 

Fixed an issue where expanding on Document Reminders 
recipient users or groups returned a 404. 

Web Services (REST API) 

 

Known Issues 
• When completing External Review from within IE9, it appears that you are able to upload a 

document via Drag and Drop.  

• When external review has been completed by a reviewer, the document history message 
may not display all of the comments.  
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• If you have a custom menu item that follows History, then it may move to the View Menu 
from the Edit Menu.   

• If a document has been sent out for external review to an invalid email address, the 
document checkout will not be cancelled. The sender will also not receive an email 
signifying that a valid recipient was not found.  

• If a document has been sent out for external review via the Review and Send for External 
Review workflow step or the Send for External Review workflow step to an invalid email 
address, the workflow step will not successfully complete. The workflow step will be left in a 
Waiting state.  

 


